G&L Modbus Serial Example Revision A 6-3-2019

Note!! This example was done with the Digital MMC Smartdrive and Drive Resident Control 16 Axis. The
programmer is responsible for any settings and wiring that are different due to differences in hardware.

Also note that the Modbus Serial ASFB library is not free-ware and must be purchased from your local
Kollmorgen supplier.

First | created a folder called Modbus Serial Example under the C:\G&L Motion Control Data directory.
This will be used later in this application note.

« v » ThisPC » SYSTEM & DATA (C:) » G&L Motion Control Data
: Indubl1_NDO.zip (s Name Date modified Type Size
AKD BASIC Servo Drive Firmware (AKD-T-1CAN-01-17-00-000).zip Applications V16.1.1 File folder
ascii_sr600 Applications V18.0.1 File folder
ascii_sr600.zip Applications16_1 File folder
[ Deskiop CIP Over Ethernet ASFB V2.2 File folder
E] Documents Ethernet IP Test File folder
Modbus Serial Example File folder
-‘ Downloads
: Meodbus TCP Example File folder
i Kollmorgen Visualization Builder IDE EN (REV 2.22.353).zip Modbusserial File folder
RIONTGISS: Open Modbus TCP ASFB V1.0 File folder
O MONTRTSR 7in A ee WAE 4 Rd oo P diaio o [ T

| put the Modbus Serial zip file in a folder | created to allow the files to be unzipped to the new folder.

« v 4 » ThisPC » Documents » G&L Modbus Serial Install Files

3ndufl1_MDO.zip (2 Name Date moedified Type Size
¢ AKD BASIC Servo Drive Firmware (AKD-T-1CAN-01-17-00-000).zip
ascii_sré00

¢ ModbusSerial.zip 8/21/201510:00 AM  Compressed (zipp... 1125 KB

ascii_srb00.zip
B Desktop
|‘::'| Documents

Unzipping and viewing the contents there is a folder called “ModbusSerial” and a subfolder called
“Serial” which contains a large number of files which will be explained shortly.

« « 4 | » ThisPC > Documents » G&L Modbus Serial Install Files + ModbusSerial > Serial
¢ 3ndub01_NDO.zip A Name Date modified Type Size o
% AKD BASIC Serve Drive Firmware (AKD-T-ICAN-01-17-00-000).zip [ C_MASTEXbin BIN File 0KB
ascii_sr600 [ € MASTEXfrc FRC File 1KB
% ascii_srb00.zip |4] C_MASTEX bk PiCPro Ladder Bac... 2KE
I Deskiop |4] c_masTEXLDO PiCPro Ladder File 2KB
] Doaiments B C_MASTEXmap Linker Address Map 4KE
C_MASTEX.rbk RBK Fil 3KB
& Downloads el i e
[ C_MASTEXrem REM File 3K
% Kollmergen Visuglization Builder IDE EN (REV 2.22.353).zip [1] c_menxLoK B e B
MON16153 4] C_MEMX.LDO PiCPro Ladder File 4KB
¢ MON16153.zip ] C_MEMX.REK RBK File 7KB
B Music [ C_MEMX.REM REM File TKE
§ P00 Tools_ 2.11ip [] c.moD.bak 211:11AM  BAKFile 36KE
9 PicPraMon15_1zip 888 C_MoD.LIB 21111 AM  Object File Library I5KE
T [] c_MODAUX.bak 211:11AM  BAKFile 5K
=] Pictures
) BB C_MODAUX.LIB 211:11AM  Object File Library 5K
B videos 4] c_moDCRC.Ibk 43PM  PiCPro Ladder Bac.. 4KB
& SYSTEM & DATA (C) ]¢] C_MODCRC.Ido 21111AM  PiCPro Ladder File 4KB
== ENG (\\RADVSVFPO2\DATAS) (F) [ € MODCRC.rbk 1243PM  RBKFile 3KB



| copied the entire ModbusSerial folder and pasted it into the C:\G&L Motion Control Data for each of
location.

- v g » ThisPC » SYSTEM 8 DATA (C:) » G&L Motion Control Data
_ 3Indubl1_NDO.zip o Name Date medified Type Size
£ AKD BASIC Servo Drive Firmware (AKD-T-ICAN-01-17-00-000).zip Applications V16.1.1 File folder
ascii_srb00 Applications V18.0.1 File folder
_ ascii_srb00.zip Applications16_1 File folder
[ Desktop CIP Over Ethernet ASFB V2.2 File folder
[ Documents Ethernet [P Test File folder
Modbus Serial Example File folder
l- Downloads
o y 5 Medbus TCP Example File folder
i Kollmorgen Visualization Builder IDE EN (REV 2.22.353).zip N ] File folder
MON16153 Open Modbus TCP ASFB V1.0 File folder
£ MON1B153.2ip PiCPro V16.1 Monitor Edition File folder
J" Music PiCPro V16.1 Professional Edition File folder
g P7000_Tools_2.11.zip PiCPro V18.0 Monitor Edition File folder
_ PiCProMonV16_1.zip PiCPro V18.0 Professional Edition File folder
Dirh £ Applications16_1 zip Compressed (zipp... 374,330 KB

| created a new subfolder called ModbusSerial_ASFB in the C:\G&L Motion Control Data folder to group
the required files using the method described in the manual shown below.

Remember the *.LIB files and *.LDO source files must reside in the same folder.

1.3 Installation

The Modbus software disk contains the files listed below. The Main group includes
the ASFB library (LIB), source ladders for the ASFBs (LDOS%, and remark files
containing the comments in the source ladders ((REMs). The Example group
includes the example LDO and REM files. The Auxiliary group contains the LIB,
LDQOs, and REMs for the UDFBs used in the source ladders for the ASFBs.

NOTE: It should never be necessary for you to access any of the files in the
Auxiliary group. The LIB is required in order for the ASFB to work and the LDQOs
allow you to view the source ladders when troubleshooting if necessary.

Follow the guidelines found at the beginning of the manual. Always make a back up
copy of the disk and store the original in a safe place. The recommended destination’
directory for each file is listed in the last column.



“m SYSTEM & DATA (C:)

Group File Description Directory
Main C_MOD.LIB The library containing the application specific = ASFB
function Block used to perform Modbus
COMMUNICANONS.
C_MODSLV.LDO ll}"{le ﬁnmce ladder for the transceiver function ~ASFB
ock.
C_MODSLV.REM | The remark file for the source ladder ASFB
C_MODMST.LDO | The source ladder for the C MODMST ASFB
function block.
C_MODMST.REM | The remark file for the source ladder ASFB
ixample |C_MASTEXLDO |The example for Modbus master LDO from | Working
C_MASTEX.REM | which you can build a new application LDO or
to which vou can merge an existing one.
C MODEX LDO The example for Modbus slave LDO from Working
C_MODEX.REM |which you can buld a new application LDO or
to which vou can merge an existing one.
\uxiliary |C_MODAUXLIB | The library that holds all the function blocks = ASFB
used m the source ladder for the ASFB.
C MODCRCLDO | Source ladder ASFB
C_MODCRC.REM | Remark file ASFB
C_MODMEM. LDO | Source ladder ASFB
C_MODMEM.REM | Remark file ASFB
C_MODMOV.LDO | Source ladder ASFB
C_MODMOV.REM | Remark file ASFB
C MODPAKIDO | Source ladder ASFB
C_MODPAK.REM | Remarkfile ASFB
C_MODUNPLDO | Source ladder ASFB
C_MODUNP.REM | Remark file ASFB
The 14 files for the “ASFB” folder are shown below.
v » ThisPC » SYSTEM & DATA (C:) » G&L Motion Control Data » ModbusSerial_ASFB
4 3ndub01_NDO.zip L] MName Date modified Type Size
AKD BASIC Servo Drive Firmware (AKD-T-ICAN-01-17-00-000).zip [ C_MODUNP.rem 224/ REM File KB
ascii_sr600 4] c_MODUNP.Ido PiCPro Ladder File 2B
ascii_srb00.zip | ] C_LMODSLV.rem REM File 13 KB
[ Desktop |4] c_MODSLY.Ida PiCPro Ladder File 17KB
[E Documents | | C_MODPAK.rem REM File 1 KB
3 Downloads |4] c_MoDPAK.Ido PiCPro Ladder File 2KB
= | ] C_LMODMST.rem REM File 10 KB
i Kellmorgen Visualization Builder IDE EN (REV 2.22.353).zip I':I C_MODMST.Ide PiCPro Ladder File 16 KB
MON16153 [ c_MODMOV.rem REM File 1 KB
i MON16153.zip |4] c_MODMOV.Ide PiCPro Ladder File 2KB
J'! Music | | C_LMODCRC.rem REM File 3KB
2 P7000_Tools_ 2.11.zip |4] c_MODCRCldo PiCPro Ladder File 1KB
PICProMon16.1.7ip FiE C_MODAUX.LIB Object File Library 5KB
s B #8§ C_MOD.LIB Object File Library 36 KB
ﬂ Videos



In this application the Digital MMC Drive Resident Control will be the Modbus Slave.

ixample | C_MASTEXLDO

The example for Modbus master LDO from

C_MASTEX.REM | which you can build a new apphcation LDO or

to which vou can merge an existing one.
C_MODEX LDO The example for Modbus slave LDO from

C_MODEX.REM | which you can bwld a new application LDO or

to which vou can merge an existing one.

! Working

Working

| saved the C_MODEX.LDO and C_MODEX.REM files to the “Working” directory which will be the
Modbus Serial Example folder created at the beginning of this application note.

G

These files can be renamed if desired but | left them as is.

v » ThisPC » SYSTEM & DATA (C:) » G&L Motion Control Data » Modbus Serial Example

&L Mation Contrel Data ~ Name
Applications V16.1.1 |¢] ¢_MODEX.LDO
Applications V18.0.1 | | C_MODEX.rem

Applications16_1

CIP Over Ethernet ASFB V2.2
Ethernet [P Test

Medbus Serial Example
Modbus TCP Example

E

Date modified

5/18/2011 4:49 PM
5/18/2011 4:49 PM

Next | created a project also saved to the Modbus TCP Example folder.

Once the project is created the following paths were setup.

Type

PiCPro Ladder File
REM File

The MAIN.LDO is the C_MODEX.LDO copied into the Modbus Serial Example “working” directory.

The PicPro Library paths point to the standard libraries for this version of PicPro, the ModbusSerial_ASFB
folder ( created just previously ), and the standard ASFB library for this verion of PicPro ( part of the
Applications disk install ).

-

PROJECT NAME: [CAG&L Motion Control Data\Modbus Serial Example\Modbus_Serial_Example.PRJ]

~[@ mam oo

-------- ] ©:G&iL Motion Control Data\Modbus Serial Example\C_MODEX.LDO
@ COMPRESSED FILE

- [@ picpro version
- [@) Picpro LiBRARY PATHS

*.PATH CA\G&L Motion Control Data\PiCPro V18.0 Professional Edition\LIERARIES
-PATH C:\G&L Motion Control Data\ModbusSerial_ASFE
L.PATH CAG&L Metion Control Data\Applications W18.0.1\ASFE
@ UDFBs/ TASKs
@ SERVO SETUP FILES
@ SERCOS SETUP FILES
@ PROFILE SETUP FILES

g orverLes

[ I,




Under the View pull-down menu->Hardware Declarations | configured this for the hardware of my demo.
This will depend on your hardware.

File Edit Tools Help

A B Hardware 140 E=panzion Option
E| Master Hack = Master Rack Only
i -5l 1 Empty ~
i - Slot 2 MMC Digital Resident 16 Axis Serva 1.3M Application
- Black 140 {+ Block [/0
-~ Block 1 [n/Out 248% DC (3 In 8 Out Src.]
- Black 2 Empty 10 ConfigdScan Options
- Blozk 3 Empty o
Cl|
- Block 4 Empty e
- Block 5 Empty Reconfigurable Block 140
- Block B Empty ¢~ and continue to scan with

Mazter Back. Remate

- Block 7 Emphy Fiack or Block 140 failures

-~ Block 8 Emply
- Block 3 Emply
- Block 10 Emply .
- Block 11 Emply
- Block 12 Emply
- Block 13 Emply

- Block 14 Empty Poal Memary Option
- Block 15 Empty B
v - Block 16 Emote

SPACEBAR for kepboard access to board selection popup menus.
SHIFT + F10 for keyboard access to edit command popup menus.



Note there are serial port settings in the Software Declarations.

| left them as is. This may vary depending on your hardware.

I':I Software Declarations : Main Ladder - [C_MODEX.LDO]
File Edit Tools Help
Name Type A. | VO Point Initial Value Long Name
REVOD BOOL Example\.LDO\Revision\Hum...
IR <fb=C_MODSLY Modbus\Slave\Driver
BOOLS BOOL(D..1) Beoleans:\0On Modbus 00001 to...
INTEGER INT{0..55) Integers:\0On Modbus 40001 toh...
T PORTADDR STRING[15] USER:S00 SeriahPort\Name
" | PORTCFG STRING[15] 9600 E, 8,1, NS00 SerialPort\Configure\String
"| ReMD STRUCT Received\Commandsiinformatiol...
ADDRESS USINT Address ofincomminghComman...
FUNCTION USINT Function\Number ofincomming?..
END_STRUCT
MOD_OK BOOL init Ok flaghi
MOD_FAIL BOOL init\failure\flagh
WMOD_ERR INT init\failure\error codel
MOD_MSG BOOL messageireceivediflagh
EXCEPT BOOL(D..7) UsenDefinable\Exception\Status
WMOD_TERR BOOL transhactionverror flagh




Here is the Modbus Slave function block. Once downloaded we will animate it.

C_MODSLV C_MODSLY
Communications- EN (K
MOdbus Slave JADDR FAIL
function block

) PORT ERR}
Allows the PiC900 to

be used as a slave with {CFG ROMDE
the Modbus protocol. 1800L

1 BSIZ
DATA
1D31Z
{EXPT
iR
{ASCI

See the Modbus ASFB manual for more details on the 1/0 of this function block.

A topic of interest is the input for BOOL ( type of data ) which starts at BOOLS[0] and the input BSIZ
indicates the size of the BOOLS array which is 2. This can be expanded ( later ).

e Network #4
This function enables the PiC300 to be a Modbus Slave owver an RS523Z connection.
5LV
C_MODSLV
MOD_OK
- ENO5 OKf——{s}—
MOD_FAIL
1 »—{ ADDR FAIL ——(s}—
PORTADDR  »— PORT ERR — MOD_ERR
MOD_MS5G
PORTCFG 7—1 CFG RCMD —( )—| )
MOD_TERR
BOOLS[0] »— BOOL TERR —( )—| _
2 7 B3IZ CODE [ — MOD_CODE
INTEGER[0] »— DATA
100 »— D3IZ
EXCEPT[0] »— EXPT
RCMD —R
- ASCI




Prior to downloading the sample ladder here are details on the hardware used in this example and the
wiring scheme. Refer to the appropriate hardware/installation manual for your specific hardware.

For serial Modbus the User Serial Port ( C3 ) is used on the Drive Resident Digital MMC Control.

Figure 13-1: The Drive Resident Digital MMC Control

Scan LED (5)
Diagnostic LED (D2
Yttt (D2) (Green)
Block /O Port [C1)*
(9-Pin Standard D-Shell)
ToPCor @5 | User Serial Port (C3)
HMI T 11| | (15-Pin High Density D-Shell)
Ethernet Link LED* | °
{Green) } ] thernet Activity LED*

.-'.-zi

4

|

Ethernet Communications Port (C4)*
(RJ-45 8-Pin)

b i

General IO Port (C5)
{26-Pin High Density D-Shell)



Although the C3 port has both R$232 and RS485 interface capability for this demonstration | used RS232.
| used a USB to Serial converter and a DSUB9 connector to DSUBHD15 cable to make the serial
connection between my PC and the User Port. Check your hardware manual for your PC or HMI to
determine what your connections should be.

PC User Port
Pin Description | Pin Description
3 X 9 RX
2 RX 10 X
5 GND 8 GND

Table 13-9: User Port Pin Assignments
Pin Signal In/Out Connector Pinout
1 NC MN/A
2 NfC A
3 N/C A
4 ﬁgﬁ&gﬂ?mademinal-rﬂaﬂy Out
5 RS232 Request-to-Send Out 15-pin HD mada D-cuby
& MG MN/A
7 RS232 Clear- to-Send In
8 Signal Ground InfCut
g RS232 Receive Data In
10 RS232 Transmit Data Out
11 N/C A
12 RS485 Receive Data + In
13 RS485 Receive Data - In
14 RS485 Transmit Data + Out
15 RS485 Transmit Data - Ot
gﬁg{remﬂr Drain In




Table 13-11: User Port to RS-232 Exter HMI Cable

Part Mumber: M.1302 8453
Length: 4 M {13 fi)
Cable type: 24 AWG, shielded, twisted pair, 4 conductor.

9-Pin female D-sub (to
Exter HMI COM2 Port,
face view)

15-Pin HD female D-sub
(to User Port, face view)

] E

| (=g

Pin Signal Pin Signal Notes
9 Receive Data 3 Transmit Data Twisted
10 Transmit Data 2 Receive Data Pair

& Signal Ground 5 Signal Ground

Shell | Drain Shell Drain

This is consistent with what is offered in the Serial Modbus ASFB manual:

Cable connections

The pinouts for the various Modbus communications connections are shown below.
Choose the one for your system.

PiC900 to an operator interface

PiC900CPU to an operator interface

(1 O-pin screw terminal) (25-pin female)
GND 8 7 GND

RECV 9 2 TRANS

TRANS 10 3 RECV

PiC900to aPC

PiC900 CPU toa PC

(1 O-pin screw terminal) (9-pin female)
GND 8 5 GND

RECV 9 3 TRANS

TRANS 10 2 RECV




Finally, | saved the ladder changes and project and then compiled and downloaded it to the control and
animated. In my case | used Ethernet to connect to the Digital MMC Drive Resident Control so my serial
connection ( USB to Serial in my case ) would be used for Serial Modbus and to view the PicPro ladder
online | used Ethernet.

PR.J ¥ |IP: 192.168.0.80

Note the E_MODSVR is enabled, SCON_OK and error outputs are all zero.

b network #4

This function emnables the PiC3%00 to be a Modbus Slave over an RS5Z3Z connection.

5LV
C_MODSLV
MOD_OK
ENOS5 oK —(s
’ " MOD_FAIL
1 ~—{ ADDR FAIL | — (S}
'USER:S00© ' +0
PORTADDR “—| PORT ERR |— MOD_ERR
" '9800,E,,1,N500° " MOD_MSG
PORTCFG  »—| CFG RCMD ——{ }—
HO MOD_TERR
BOOLS[)] >— BOOL  TERR ——f }—
+0
2 +— BSIZ CODE |—3 MOD_CODE
+{ ’ ’
INTEGER[0] >— DATA
100 ! DSIZ
O '
EXCEPT[0]  »— EXPT
RCMD R
ASCI

End of Module

11



Next using Modbus Poll as the Modbus Serial master and to check if values can be written.

RTU mode is selected as follows:

Connection Setup X

Connechion 0K

Serial Part w

Cancel

Serial Settings

I15E Serial Port [COMZ] w tode

@ RTU O ASC
600 EBaud

Rezponze Timeaout

3 D ata bitz o
1000 [mnz]

Ewven Parity
Delay Between Pollz

1 Stop Bit - Advanced... [mz]

Remate Madbuz Serer
IF Addresz or Mode MName

192 168.0.80
Server Part Connect Timeout =)
A02 2000 [mnz] =0

RTU mode is selected by the C_MODSLYV block as follows:

- SLV1
C_MODSLV
MOD_OK
= ENOS ok ——{fs}—
MOD_FAIL
1 »—{ ADDR FAIL ——{8}—
"USER:$00" 0
PORTADDR >—| PORT ERR —3 MOD_ERR
" '9600,E8,1,NS00" " MOD_MSG
PORTCFG  »— CFG RCMD |— —
HO ’ " MOD_TERR
BOOLS[] >— BOOL  TERR — }—
0
10 — BSIZ CODE |— MOD_CODE
#1234 ’ '
INTEGER[0] —| DATA
100 — DSIZ
NO '
EXCEPT[0] 3— EXPT
RCMD  —R
If not set 4 asci
henRTU —
mode

12



Per the Modbus Slave ASFB the PORTCFG input is for 9600, E, 8, 1 so Modbus Poll is configured with the

same settings:

Connection

Serial Part

Senal Settings
LISE Serial Port [COK2)

9600 Baud
8 Data bit:
Ewven Parity  w
1 Stop Bit e

Remaote Modbuz Server

192.168.0.80

502 2000

Advanced...

]
Caricel
tode
(®RTU () ASCH

Reszponze Timeout
1000 [mz]

Delay Between Pollz

ms]

[Fed
[PE

Next In Modbus Poll setup a Read/Write Definition. A very important setting is the Slave ID. This value
needs to match the input value of ADDR in the C_MODSLYV function block in Picpro. In this example it is 1.

B File Edit Online Compile Ladder View Window

Dledl slele sleel € =

@B [0 B =5l
4_DT_T +] ] Rl

2 =l 8l

Help

BOOLS[D] — BOOL TERR

- 5LV
C_MODSLY
=t ENO5 OK
——
1 ] ADDR FAIL
"USER:S00"
~ PORTADDR >—| PORT ERR
'9600,E,8,1,H500"
PORTCFG  — CFG RCMD
NO

MOD_OK
5 9
D_FAIL

—{s}—
+0
— MOD_ERR
MOD_MS5G

—{ —

IMOD_TERR

+0

Slave ID: aK
Function; | 16Trite Multiple Registers w Cancel
Address: I:l Protocol addrezs. E.g. 40011 > 10
Cuantity:

Scan Rate: [mng] Apply

Dizable
[] ReadAwfrite Disabled
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Initially the starting address will be zero and not using Base 1. If you want the convention to follow the
chart in the Modbus Serial ASFB manual then the PLC Addresses ( Base 1 ) checkbox needs to be
checked. With the first test we will attempt to write to the first to INTEGERS in the G&L.

Slave ID: oK
Function: | 16%rite Multiple Registers w Caricel
Addrezs: I:I Protocol address. E.g. 40011 - 10
[uantity:

Scan Rate: [ms] Apply

Dizable
[ ] Readwiite Dizabled
[ ] Dizable on emor Read frite Once
Wig
Rowsz
@10 20 (Cs0 (100 CFit o Quantity
[ ] Hide &lias Columns [ ]PLLC Addresses [Base 1]
[] &ddress in Cell ] Enron/D aniel tode

On connection there are no errors so for demonstration purposes | set the first 2 registers to values
1234 and 5678 respectively.

[=[@][=]
Tx=4345 Er=1.ID=1.F=16: SR =40ms

Alias 00000
1234

[ oo |~ o [wn |4 wa [ = |

14



Now switching back to the animated ladder in PicPro | used the View List to monitor the values.

Enable Name Type Value
X INTEGER[0] : Signed Decimal +1234

X INTEGER[1] : Signed Decimal +5678

Keep in mind some Modbus TCP masters start their address at 1, 40001, 400001, etc. where 1 will likely
be equivalent to DATA[O] which is an offset in addressing.

The following yields the same result ( Base 1 addressing ):

Slave ID: oK
Function: | 16 *%/rite Multiple Reagisters W Cancel
Address; Protocol addresz. E.g. 400171 - 10
Cluantiby:

Scan Rate: [ms] Apply

Dizable
[ ] Readwiite Disabled
[ ] Dizable an erar Readfrite Once
e
R oz
@10 (20 (80 (100 O Fikto Quantity
[ ] Hide &liaz Columne PLC sddresses [Baze 1]
[ ] &ddress in Cell [ EnronD aniel Maode

15



Note the Modbus TCP ASFB manual assumes a base 1 addressing scheme. Also note the array is shown
as BOOL(x) in the chart but in the sample project the array is named BOOLS(x). Likewise the integer
array is shown as DAT(x) in the chart but INTEGER(x) in the sample project.

Message Addressing
The addressing between the PIC200 and Modbus is as follows:

BOOLEANS INTEGERS
Modbus  PiC900 | Modbus PiC900

00001  BOOL(O) | 40001  DAT(0)
00002  BOOL(1) | 40002  DAT(1)

00999  BOOL(998) | 40999 DAT}(998

To test the Boolean data | setup Modbus Poll to use function 15-Write Multiple Coils.

SlavelD: [T | oK

Function: | 15%/rite Multiple Cails w Canicel

Address; I:I Protocol address. E.g. 100771 - 10
Quantty 2|
Scan Rate: [ms] Apply

[izable
[ ] Readwiite Disabled

[ ] Dizable an erar Read™vrite Once

Wi
R oz

@10 Oz20 O50 O100 O Fitto Duantity

[ ] Hide &liaz Columns []PLLC Addresses [Baze 1]
[ ] &ddress in Cell [ Enron/D aniel Maode
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To demonstrate | added BOOLS[0] and BOOLS[1] to the View List in PicPro. NO=0 or OFF and YES=1 or
ON.

Enable Name Type Value
X INTEGER[0] :Signed Decimal | +1234
X INTEGER[1] :Signed Decimal | +5G78
X BOOLS[0] :Boolean )
i BOOLS[1] [Boolean NO

Turning on BOOLS[0] in Modbus Poll:

Y Modbus Poll - Mbpoll1 |#] PiCPro Professional Edition - [View List: C_MODEX.rtd]
File Edit Connection Setup Functions Display View Window Help

S 2| |05 06151617 2223 |TCEL| T W2

: DlDlJ xl&lﬂ él‘?lk”l 9 _I
[ZI Mbpallt [= @ =] =

Tx=1444T-Err=0:1D = 1: F = 15: SR = 40ms

7 File Edit Online Compile Ladder View Window Help

ADT_T J M] M| =

Aliasl 00000 Enable Name Type Yalue
5 1 X INTEGER[0] : Signed Decimal | +1234
1 X INTEGER[1] : Signed Decimal +5678
L 0 X BOOLS[0] :Boolean YES
E I X BOOLS[]  fBoolean HO
El ;
4]
El
6]

Turning on BOOLS[1] in Modbus Poll:

-'b"é Maodbus Poll - Mbpolll (] X I':l PiCPro Professional Edition - [View List: C_MODEX.rtd]
File Edit Connection Setup Functions Display View Window Help

EEHE X|[T|S 2|/ os0e151617 22 23|TC L[| 7 W2
21 Mbpoll’ (===

™7 File Edit Online Compile Ladder View Window Help
Dls(ul 3[le] 82 2| Gl
SB[ B CimE P = 8l

Tx =16031-Er=01D =1 F =15 SR = 40ms m@lﬁl@lﬁl
Aliasl 00000 Enable Name Type Value
7 o X INTEGER[0] | Signed Decimal | +1234
. X INTEGER[1] | Signed Decimal | +5678
X BOOLS[0]  :Boolean HO
2| % 5001 s11] " [Boolean YES
3 l
4
3|
6
i
al
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Note there are 100 INTEGERS in the setup of the sample Modbus Serial ASFB but only 2 BOOLS.

You can expand it by changing the BSIZ from 2 to X within the limit of the size of the BOOLS array
(0..998).

For example:
5LV
C_MODSLV
MOD_OK
- ENOS5 OK - {8 %—
MOD_FAIL
1 »— ADDR FAIL |- {8 %—
PORTADDR  — PORT ERR |— MOD_ERR
MOD_MSG
PORTCFG  >— CFG RCMD |- { —
MOD_TERR
BOOLS[0] >—{ BOOL  TERR |- { —
10 i BSIZ CODE —% MOD_CODE
INTEGER[0]  —] DATA
100 —{ Dsiz

It is important to note that the value of BSIZ must match the size of the array of BOOLS

File Edit Toocls Help

_I Hame I Type I A, I D Point I Initial Value I Long Hame
BOOLS |EH:I{JL(+}..1} | | | | Booleans\On Modbus: 00001 to...
il INTEGER INT(0..99) Integers:\0n Modbus:40001...
PORTADDR STRING[15] USER:E00 SerialPort\Name
PORTCFG STRING[15] 9500 E,8 1, NS00 SerialPort\Configure\String
RCMD STRUCT ReceivediCommandstinformatioh...




To extend the array size, highlight the BOOLS Type and right-click and then choose Make Array.

In this example | extended the BOOLS from 0..1 to 0..9 or from 2 to 10 elements. So input 10 into the

|%| Software Declarations : Main Ladder - [C_MODEX.LDO]
File Edit Tools Help
Hame Type A, | WO Point Initial Value Long Hame
BOOLS BOOL(0..1) Booleans:\0n Modbus:\0000...
INTEGER INT(0..99) e Integers\0n Modbus 40001 tol._.
PORTADDR STRING[15] Insert SeriahPorf\Namel
PORTCFG STRING[15] Make Array NS00 SeriahPortiConfigure\String
RCMD STRUCT Madify Attributes * Received\Commandsiinformatiol...
ADDRESS USINT Purge Unused Address ofincomming\Comman...
FUNCTION USINT Delete Function\Mumber ofincommingh...
END_STRUCT
MOD_0OK BOOL init QKA flagi

Enter Array Size box and then the Enter button on your PC’s keyboard.

I':I Software Declarations : Main Ladder - [C_MODEX.LDO]

File Edit Tools Help

Hame Type A. | WO Point Initial Value Long Hame
BOOLS BOOL(0.1) Booleans:\On Modbus:\0000...
INTEGER INT(0..55) Integers:\On Modbus: 20001 tok...
PORTADDR STRING[15] USER:Z00 SeriahPortfiNamet
PORTCFG STRING[15] 9500,E,8,1,N300 SeriahPort\Configure\String
RCMD STRUCT Received\Commandsiinformatiod...
ADDRESS USINT Address ofincommingComman...
FUNCTION USINT il e S W ymmingh...
END_STRUCT
MOD_OK BOOL init OEAflaghh
MAn FAN RMAMl intifailiira’i fland
I':I Software Declarations : Main Ladder - [C_MODEX.LDO]
File Edit Tools Help
Name Type A, | VO Point Initial Vialue Long Hame
BOOLS BOOL(0..9) Booleans:\0n Modbus:A0000...
INTEGER INT(0..595) Integers:\vOn Modbus 0001 toh...
PORTADDR STRING[15] USER:E00 SerialPort\Name’
AAnTRC ST e A o 4 menn T i Bl o s Form e b B o
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Save and Close the Software Declarations. Another addition will be a departure from monitoring using
the View List and add the capability to viewing the values in the ladder itself. Using the MOVE function
block as shown:

‘st
C_MODSLY | ) ) ) MOVE ) ) ) MOVE
MOD_OK
ENO5 ok —{s - En oK | - En oK |-
MOD_FAIL o +0
1 —| ADDR FAIL ——{(s+—  BOOLS[D]  — A ouT1 b INTEGER[O]  +— N4 ouT1 |
"USER:$00" +0 o +0
 PORTADDR >—| PORT ERR |— MOD_ERR )  BOOLS[{] {2 outz | INTEGER[] —| IN2 ouTz -
"9600,E,8,1,N500° MOD_MSG No +0
PORTCFG  —| CFG RCMD ——  +—| BOOLS[Z] +— IN3 ouTa | INTEGER[Z]  +—IN3 ouTa |
HO ' " MOD_TERR ' NO ' ' ' 0 ' '
BOOLS[0] »—{BOOL  TERR [—{ »+—  BOOLS[3]  >—| N4 ouTs [ ©INTEGER[3] >—|IN4 ouTs |
+0 O +0
10 — BsiZ CODE |—3 MOD CODE  BOOLS[@] {5 outs | INTEGER[4] | IN§ ouTs
+0 o +0
INTEGER[)] — DATA BOOLS[S] | ING ouTe INTEGER[S]  +—] ING ouTe |-
- . . . o - - - - -
100 — nsiz ) )  BOOLS[B]  >—| 7 ouT7 b ~ INTEGER[S] >—| INT ouT7 |
no No +0
EXCEPT[0] »— EXPT ) )  BOOLS[T] —{ M8 ouTs |  INTEGER[T] — N8 ouTs -
no +0
RCMD R BOOLS[E] | IN® ouTa INTEGER[E]  »—]{IN9 ouTa |-
; ot ; . . = ; .
4 ascl ) )  BOOLS[®] >— W10 ouTio |- INTEGER[S] — IN10  OUTH0 |-

| added the two MOVE blocks, saved the ladder, and the performed a Compile&Download.

Testing BOOLS from Modbus Poll:

% Modbus Poll - Mbpolll
File Edit Connection Setup Functions Display View Window Help
move | DB E&ES|X|T|E 2| |os06151617 2223 |(TC &L | 7 N2
e 7 EN Ok - Mbpell1 [=][= ][ =]
BOOLS[)]  —] M1 ouTi | Tx=1571:Er=0:1D =1:F = 15: SR = 40ms
NO ’ '
BOOLS[1]  —{In2 ouT2 - Alias 00000
YES 0 1
BOOLS[2] —]IN3 ouT3 | —
NO ' ' L 0
BOOLS[3] — N4 ouT4 | 2| 1
YES ' ' 3 0
BOOLS[4] | IN§ ouTs | 4 1
no 5| 0
BOOLS[S] | IN§ ouTs | —
YES 6| L
BOOLS[E]  »— N7 ouT? 7 0
No B
BOOLS[T]  — ING ouTs | ﬂ 0
YES
BOOLS[3]  —IN® ouTs |
NO
BOOLS[S] | IN10 oUT10
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Testing INTEGER using Modbus Poll:

hMbpoFH T — E@@

MOVE ZI Tx=996:Err=0:1D = 1: F = 16: SR = 40ms
- EN OK |- Alias 00000
+1 0
INTEGER[0]  »—{ IN1 ouTt 1
+2
INTEGER[1]  — IN2Z ouT2 | z
+3 3
INTEGER[2]  — IN3 ouTs 4
+4 5
INTEGER[3]  — IN4 ouTd 5
+5
INTEGER[4]  — IN ouTs 7
16 8
INTEGER[5]  — ING ouTE 9
+T
INTEGER[B]  — INT ouT?
+8
INTEGER[T]  — ING ouTE
+9
INTEGER[B]  — IN9 ouTs
+10
INTEGER[9]  —

IN10 ouTi0 lﬂ
3
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Using KVB with Modbus Serial

Next | will demonstrate using KVB software to do the same thing as Modbus Poll.

| started by creating a new project and selecting Kollmorgen->Modbus Master RTU/TCPIP as shown
below. Note this communication driver supports both Serial ( RTU ) Modbus and Ethernet based

Modbus TCP.
4 Choose Controller \\'l
: - Choose your preferred controller
or OPC server in the menu below
"/Ei:' Controllers h m
Select brand Select protocol
(" | 31 M r/.I"_u"lcn:llztus Master RTU/TCPIP )
- DEMO

% G & L Motion Control

\ J \ ] ————

) OPC UA Server
URL:
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Under Tags->Controllers->Settings:

Project Explorer

v Screens (1)
Q AiScreens

Screenl ) Tags X

%

[[Tags | controlers |[ Triggers | Pol Groups | Index Regiters |

Home |

Screenl
Add Delete I Controller... [ Settings. ‘ IShawSe\e(t\an. -‘
[ Name D Active
o —g——0
(D Search )
¥ Functions (4)

O Alarm Server

&) Multiple Languages

B secury

L Tags

=

Under the Settings tab | changed the Communications mode to Serial. As with Modbus Poll, the ID or in
this case called Default Station needs to be set to the same number as in the C_ MODSLV’s ADDR input
value.

B File Edit Online Compile Ladder View Window Help ) N e
Dlsldl &2l gl ¥ & Miodbus Master RTU/TCPIP %
@ IlD Il 2] % | & Settings IStationsl
&DT_T - 2 2l Modbus Master RTU/TCPIP 5.02.02 |
rsLv ZI Clisetims =
C_MODSLV MOVE | Communication mode
MOD_OK Default station T
ENOS ok ——fs}— JEN ok Modbusprotocol RTU
MOD_F HO 32-hit word mapping Maotorola
1 4—=—ADOR FAIL ——(S}— _ BOOLS[0] N1 outt |- | Addressing Decimal
‘USER:S00" +0 HO = Start address 0-based
_ PORTADDR —| PORT ERR —3 MOD_ERR . _ BOOLS[1] {2 ouT? - Max black size (words) 16 L
'9600,E,8,1,NS00" MOD_MSG NO _I Force function code 0x10 Disable
PORTCFG  ;—| CFG RCMD —( . . BOOLS[Z] »—IN3 ouT3 | I String swap Enable
NO MOD_TERR HO | | silent tme (ms) 20
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| left the Start address as the default 0-based. If you want the addressing to look like the table in the
Modbus Serial ASFB manual you need 1-based but in this example | left it at 0-based because | like the
Modbus address count to be the same as the index of the INTEGER[x] array. | also added 20msec of
silent time.

Settings | Stations |

Modbus Master RTUSTCPIP 5.02.02

B Settings -
Communication mode Serial
Default station 1
Modbus protocol RTU
32-bit word mapping Motorola
Addressing Decimal
Start address 0-bazed
Max block size (words) 16 I
Force function code 0x10 Disable
String swap Enable
Silent time {ms) 20
Clock reqister 40000

EH Communication method
Communication method Serial =

QK Cancel Help




As mentioned before, RTU mode is select in the C_MODSLYV as follows:

-SLV
C_MODSLV
' MOD_OK
« ENOS ok —{s}—
MOD_FAIL
1 »— ADDR FAIL |- {5 —
'USER:$00" £0
PORTADDR —| PORT ERR |—3 MOD_ERR
'9500,E,8,1,N$00° " MOD_MSG
PORTCFG  — CFG RCMD {
NO ' ' MOD_TERR
BOOLS[0] — BOOL  TERR |- { +—
+(
10 ! BSIZ CODE —3 MOD_CODE
+1234 ' '
INTEGER[0] »— DATA
100 ! DSIZ
NO '
EXCEPT[0] — EXPT
RCMD (R
I not set 4 ASCI
thenRTU —
mode

Scrolling down under Communications Method | selected Serial and set the serial port settings to match
that of my PC ( which | am using as the Modbus Serial Master ) This will need to be set according to your
hardware that you are using for the Modbus Serial Master.
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Modbus Master RTU/TCPIP x>

Settings |5tajons|
Modbus Master RTU/TCPIP 5.02.02

Clock reqister 40000
EH Communication method
Communication method
Part
Baud

Data bits
Stop hits
Tunneling protocol TCP
Tunneling IP address 192, 168.98.2
Tunneling part a004
Tunneling local UDP port 0

Advanced

[ Routing =

Parity
Set the parity for the selected COM port.

oK Cancel Apply Help

The Stations tab is for Ethernet based communications so | left it at default.
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Next | created 4 tags 2 of the BOOL type and 2 of the INT16 type. Note the addressing is 0-based.

Screen] x° Tags X

J Tags || Controllers || Triggers || Poll Groups || Index Registers )
Home |
Columns Visible Filter
[ Add = [ Delete - Scaling Cthers
[] Data Exchange
L =
Tag Controllers Scaling Others
Mame Data Type Access Right | Data Type Controller 1 Offset Gain Read Expr. .. Write Expr. .. Description
BOOLS_0 BOOL ReadWrite BIT Q0000 a 1
INTEGER._O INT16 ReadWrite INT16 40000 a 1
INTEGER_1 INT 16 ReadWrite INT16 40001 1] 1

Next for Screen 1 | added 2 Buttons and 2 Analog Numerics. | changed the labels on the buttons

accordingly and put text labels above the 2 Analog Numerics.

INTEGER[O]
[
BOOLS[0] #
| INTEGER][1]
BOOLS[1] #
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Next it is required to associate a tag and action to each graphic on the screen.

First with the BOOLS[0] button. Set the Mouse Down and Mouse Up as shown so the operation of the
button is on press BOOLS[O] will be 1 or ON and on release BOOLS[0] will be O or OFF.

e
General Actions

Select Action... = Set Analog = Set Analog =
BOCLS_ 0 = BOOLS.0 5

INTEGER[0]

BOOLS[0] 1 #

INTEGER[1

BOOLS[1] #
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Repeat for the BOOLS_1 button:

rvprerues -

= Select Action... = Set Analog = Set Analog =

BOOLS_1 - || Boots: -
_'—J

INTEGER[0]

BOOIiS:E{J:] #

INTEGER[1

BOOLS[1] | #

Next the Analog Numeric fields will be configured. The tag is selected, Integer type, and On Input is
setup to limit the input from the HMI to be within a valid range for a 16 bit signed integer.

B~ tome Project  System  Imsert  View  Dynamics |[Rogll  Actions

Integer « | | Zero Fill | Prefix INTEGER_O . Auto Stretch Font = [¥] On Input | | On Display
.| Limit Charactersto 10 Suffix Select Security Groups.. ~ Disable Operator Input = Lower Limit  -32763
Number of Decimals 1 - Transparent Upper Limit 32767

Project Explorer

¥ Screens (1)
© Ailscreens

Screenl

INTEGER[0]

BOOLS[0] " # »

INTEGER[1
#
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Repeat for INTEGER[1]:

B~ Home Project System  Insert  View  Dynamics (RO  Actions

Integer - Zero F Prefix INTEGER 1 ~ = Auto Stretch Font [¥] On Input On Display
Limit Charactersto 10 Suffix Select Security Groups... * Disable Operator Input | = __ Lower Limit  -32768
Defacl | Upper Limit 32767

Number of Decimals 1 Defa Transparent ‘

D 3 Y P T 1T S S 0 L —

Project Explarer Screent X

¥ Screens (1)
Q Alsereens

Screenl

INTEGER[0]

bas0

#

BOOLS[0]

= INTEGER[1] .
sooisy | # : -~

e———©0

(Q Search Q)

After Save, Build, Run....

On press of the BOOLS[0] button in run-time:

I e _SET I _ IV
MOVE ) . ) N
- EN OK . - EN
YES +1
BOOLS[0]  — IN1 ouT1 | ~ INTEGER[0]  — IN{
Ho +2 BOOLS[0]
BOOLS[] — IN2 ouTz |  INTEGER[1] »— INZ
NO +3
BOOLS[2] —IN3 ouTs | ~ INTEGER[Z] —IN3
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On press of the BOOL[1] button in run-time:

NO
BOOLS[0]
YES
BOOLS[1]
NO
BOOLS[2]
NO
BOOLS[3]

HO
BOOL 5[4]

LT T T T

NO
BOOLS[5]
NO

BOOLS[6]

T T

EN

N1

N2

IN3

IN4

IN5

ING

INT

MOVE

OK

ouT

ouT2

ouT3

ouT4

ouTs

ouTe

ouTr

MMC_Sernal_Modbus -

BOCLS[O]

BOOLS[1]
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From the Modbus Poll the values were set in the INTEGER array. Initially KVB in run-time shows

INTEGER][O] as a value of 1 and INTEGER[1] as a value of 2.

+1
INTEGER[0]
+2

+3
INTEGER[2]
+4
INTEGER[3]
+5
INTEGER[4]
+6
INTEGER[5]
+7
INTEGER[&]

i

]

INTEG En[ﬁl\k

[

T 1T 1T 1T

=
MOVE

EN oK |-
o — L
Nz out2 -

N3 ouTs |- L

INa ouT4 \
N5 ouTs |-

ING ouTé |-

INT ouTT |-

INTEGER[0]

INTEGER[1]

Clicking on the 2 data fields and changing the values:

+1234 —

INTEGER[0]
+5678

INTEGER[1] “P-<

INTEGER[H
+4

INTEGER[3]
+5

INTEGER[4]
+6

INTEGER[5]
+7

INTEGER[&]
+3

=

1

T T 11T

EN

IN1

N2

N4

IN5

IN&

INT

MOVE

OK

ouTH

ouT2

ouT3

ouT4

ouTs

ouTE

OUTT

INTEGER[0]
P 1234
_' E

INTEGER[1]

\ 5678

This concludes the Modbus Serial Example.
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